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Chapter 1: 
Getting Started with 
Your Tablet PC

The Tablet PC is a full Windows XP computer. Just like a desktop PC or laptop, the Tablet PC runs all the familiar applications, such as Microsoft Word, Excel, and PowerPoint. And it offers Internet connectivity. 

But the Tablet PC adds the functionality of pen and paper: you can write on the screen, so it’s perfect for common school and classroom tasks, such as taking notes during a presentation or lecture or writing feedback on a document. 

This guide will introduce you to the basic uses of the Tablet PC, including how to use the tablet pen instead of a mouse and how to take notes and mark-up existing electronic documents with the pen and tablet. 

What Is Tablet PC?

First and foremost, Tablet PC is a full Windows XP computer. It runs all of your familiar productivity applications such as Word and PowerPoint, and offers the same connectivity to the Internet that you expect from your desktop or notebook PC. What the Tablet PC adds is the simplicity of pen and paper. Because you can write on the screen, it's optimized for tasks that are very common in a school setting, such as taking notes during a presentation or other live event or writing feedback on a student's document.  

Tablet PC can serve as your primary PC. You can have your email and calendar, your lesson plans, and all your other files with you at all times without the need to sync or port your Windows applications. 

Tablet PC can convert your handwritten notes into typed text. But it can also treat "ink as ink"​​---allow you to revise, edit, and re-purpose handwritten notes after you’ve written them on the computer screen using the stylus, or pen. Therefore, pen input is equal in flexibility and power to input from a mouse or keyboard. That means handwritten notes can remain as ink and can be edited and even indexed, or they can be converted to text.

Features and Capabilities

Tablet PC enables you to:

Extend the way you work with your PC. Tablet PC lets you incorporate the convenient and intuitive aspects of pen and paper into the PC experience. Using a tablet pen and Tablet PC Input Panel, you can write directly on the tablet screen and save your notes in your own handwriting—or convert them to typed text for use in other applications. The pen can also handle common mouse and keyboard tasks like opening applications, selecting text, and displaying menus. Or, if you prefer, you can still use a mouse or keyboard with Tablet PC.

Work from anywhere. Tablet PC is a portable device that can be plugged into a power source or that can run on a battery, so you can take it with you. It provides everything you expect in a mobile PC, but in a form that allows you to be productive in more situations—at your desk, in the hallway, in a meeting, or on the go. Tablet PC comes in two basic forms: the "convertible," with an integrated keyboard, and the ultra-slim "slate tablet," which has innovative docking solutions for easy access to the keyboard while at your desk. When you’re away from your desk, the tablet itself replaces a keyboard, so rather than enter text by typing on a keyboard, you can enter text into Word documents or any other Windows XP-compatible application by writing on your tablet. The handwritten text is then converted into typed text in the application.

Take notes electronically. Windows XP Tablet PC Edition comes with Microsoft Windows Journal, a note-taking utility that lets you create and organize your handwritten notes. Think of Journal as an electronic pad of paper. Windows Journal makes it easy to capture the text and drawings you would normally create using pen and paper. Advanced handwriting recognition technology lets you search your handwritten notes to quickly find what you need.

Import documents into Journal: One of the most powerful features of Tablet PC is the ability to import files into Windows Journal and use your tablet pen to annotate these document images. You import files by "printing" them to Windows Journal. Reports, forms, presentations, spreadsheets, graphics, photos, and Web pages can all be imported into Windows Journal. If you can print it, you can import it into Windows Journal and annotate it without changing any of the original content of the imported file. 

System Requirements

This book will focus almost exclusively on Windows XP Tablet PC Edition and the Office XP Pack for Tablet PC. To perform most of the actions described in this book, you need only a tablet with Windows XP Tablet PC Edition installed. There are several versions of tablet hardware; the exact model should not matter.

The Tablet Stylus, or Pen

One thing you will find as you use different programs on your tablet is that they support pen input at different levels. Don’t worry—all programs that run on Windows XP, even those created before the tablet existed, will allow you to use the pen in place of a mouse and input text using the Tablet PC Input Panel described in Chapter 2. In addition, some software will provide areas for you to enter handwritten information directly into documents as images and control the program through pen movements called gestures. At the highest level of integration, some programs allow you to store the original pen inputs as well as reformat and edit them. Some of these programs come already installed with Windows XP Tablet PC Edition. Others are in development. The possibilities are thrilling.

There are xe "pen"

xe "tablet pen. See pen"really two things to learn about the tablet pen. The first is what you can and cannot do with it and the second is how you actually use it. There are basically five things you can do with the pen and different situations in which you can do them.

· Use your pen instead of a mouse   The pen can be used instead of a mouse at any time in any application in which you could use a regular mouse. The pen can provide both left and right mouse button actions.
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Use your pen in lieu of a keyboard as a text input device   The pen can be used to input text at any time in any application in which you could use a regular keyboard. The pen accomplishes this using Tablet PC Input Panel.

· Create ink that becomes a static image   Some applications accept pen inputs and convert them into images. The images can be inserted into documents or attached to e-mail messages.

· Create ink that becomes both a static image and converted text   Some applications can contain the image of the ink you created and the text recognized from the handwriting. For example, Microsoft Word 2002 with the Microsoft Office XP Pack for Tablet PC allows you to insert your handwriting into a document and shows you the results of converting the handwriting to text.

· Create rich ink   Currently, only a few applications have this highest level of pen integration, but many more are in development. In this case, you can edit, format, and even search the ink you created.

Using a Pen in Lieu of a Mouse

Until using your pen instead of a mouse is second nature, xe "pen:how to use"you can’t really enjoy your tablet. One fundamental skill is moving the cursor. The pen should not make contact with the screen if you only want to move the cursor. In fact, as soon as the pen gets close enough to the screen, the cursor will jump to the pen’s position, so you rarely need to move the cursor around the screen as you did with a mouse. Just to get a feel for the pen, though, try moving the cursor to various items on the screen, such as the Start menu, and hovering in place until the ToolTip comment appears.
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When the pen does make contact with the screen, that is the equivalent of a click with the left mouse button, so you must make contact to tap (click) or drag. The key to a good tap or drag is tapping hard enough for the screen to register the contact but not pressing down excessively. This comes quickly with a little hands-on experience. As you practice, here are some tips for successful mousing with a pen and the logic behind them.

· Rest your hand on the screen   This is counter-intuitive to anyone who has used a Palm Pilot or a Pocket PC, where the screen is touch-sensitive. Because it’s the pen of the tablet that is sensitive, not the screen, you can rest your hand with no adverse effects. It is much more comfortable and easy to use the pen if you rest your hand.

· Hold the pen like a regular pen   Resist the urge to hold the pen like a pointer. However you hold a real pen is the way to hold the tablet pen.

· Press firmly and tap with gusto   The screen on your tablet is built for writing. You can’t break it with the pen. Press firmly when you write and tap with a hard, short whack. As you get used to the tablet, press and tap with less pressure until you find the amount that works best for you.
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Watch the cursor, not the pen   Particularly, watch the point of the cursor arrow. The alignment between the pen tip and the cursor is good but not perfect. If you tap an icon and nothing happens, the most likely cause is that the pen is over the icon, but the cursor is a bit off. It’s the position of the cursor on the screen, not the pen, that ultimately matters to the computer.

· Get a better pen   If your tablet came with a small stylus instead of a full-size pen, invest in a more comfortable pen. The more comfortable the pen, the easier it is to use. I’ve also noticed that some pens seem to have better cursor alignment than others. If you aren’t happy with your pen, try others until you find one that works well for you. Make sure you get a pen that works with your particular tablet. 
Using a Pen for Right-Click and Right-Drag
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Research shows xe "clicking and dragging, how to"

xe "right-clicking and right-dragging, how to"

xe "dragging, how to"only about 30% of Windows users ever use their right mouse button. This is too bad, since a right-click gives you instant access to context-sensitive shortcut menus full of useful commands. On a tablet, these menus save perhaps even more time and effort, so you should definitely know how to right-tap and right-drag. To get a good right-tap, hold the pen down longer until the right-tap icon appears and then lift the pen completely off the screen. Next highlight the desired item on the shortcut menu while hovering. Finally, tap the selected menu item.

Pens with a button for a right-tap make the process quicker and easier. To right-tap with a pen button, hold the pen button down before you make contact with the screen, tap the point where you want to right-tap, and lift the pen back off the screen before releasing the pen button. The right-tap menu will appear where you tapped. The pen button is also the only easy way to right-drag on a tablet, such as you might do when you wanted to move a file from one folder to another rather than copying it. To right-drag, hold the pen button down before you make contact with the screen, press down and drag the item you want to move. Lift the pen off the screen before you release the pen button, and the shortcut menu will appear over the icon you just dragged. The disadvantage to using the pen button is that if you move the pen laterally too much as you right tap, you can accidentally right-drag and get the wrong shortcut menu. If this happens, tap anywhere on the screen other than the menu. If it happens to you often, try changing the pen tolerances in the Tablet And Pen Settings control panel.

Using the Tablet PC Tutorials

When you xe "tutorials:Welcome To Tablet Computing tutorial"

xe "Welcome To Tablet Computing tutorial"power up your new tablet for the first time, you’ll see the Welcome To Tablet Computing tutorial, shown in Figure 1-1, designed to give you the basics of using your tablet’s unique features. Take a few minutes to go through at least the first six screens, which give you practice using the pen in place of a mouse. Without this practice, your first hour with your tablet will be very frustrating. After the practice section, the next seven screens give you an overview of inputting text using the pen, but there are no opportunities to practice and subsequent tutorials do a much more thorough job on this anyway. Skim through them if you wish, and quit the program. We will cover using the pen to input text in depth in Chapter 2. The most important thing to practice now is using your pen in place of a mouse, particularly pointing the cursor, single-tapping, double- tapping, and right-tapping.
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Figure 1-1.   Use the welcome tutorial to practice using your pen in place of a mouse.

Switching the Screen Orientation

The Welcome To Tablet Computing tutorial should be done with xe "display. See screen"

xe "monitor. See screen"

xe "orientation, screen"

xe "screen:orientation, switching"your screen in portrait orientation (longer than it is wide) and with the pen as primary input. If your tablet does not have an attached keyboard, it should start up this way. If your tablet can also function as a laptop, it will probably start in landscape screen orientation and with the keyboard and touch pad accessible for input.

The exact process to stow or remove your keyboard and otherwise reconfigure your tablet varies, so you’ll need to check your owner’s manual. Switching the screen orientation is part of Windows XP Tablet PC Edition and can be done three different ways. Switching the screen is something you might do several times during the day.
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Use the Change Tablet And Pen Settings icon in the notification area[image: image95.bmp] Single-tap or right-tap on the Change Tablet And Pen Settings icon and select Change Screen Orientation from the shortcut menu shown in Figure 1-2. The screen will switch to the next of the four possible orientations set in the control panel. Continue to switch until you see the screen orientation you want. If you don’t want to use all four possible screen orientations regularly, go to the Display tab in the Tablet And Pen Settings control panel and tap the Change button next to Sequence. Select the orientations you want in the order you want them to appear and set the remaining options to (None). If you have only two options chosen, as most people will, the Change Screen Orientation command will toggle between those two.
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Figure 1-2.   Change Tablet And Pen Settings in the notification area gives quick access to commonly used commands. 
Using the Built-in Tablet Tutorials

The Welcome To Tablet Computing tutorial only launches the first time you use your tablet. There are four more built-in tutorials that provide an overview of tablet computing and introductions to Input Panel, Windows Journal, and Speech input. xe "Input Panel tutorial"

xe "Windows Journal tutorial"

xe "Speech tutorial"The tutorial home, shown in Figure 1-4, will appear every time you start up your tablet until you tell them to go away by checking Do Not Show Me This Again. If you want to run the tutorials after you check this box, go to the Start menu, tap All Programs, tap the Tablet PC folder, and tap Tablet PC Tutorials. We will cover Input Panel in Chapter 2 and explore Windows Journal in Chapter 3. Some basic use of Input Panel is necessary to simply get going on the tablet, so, if you haven’t done so already, view the video portions of Tablet PC Tutorial and Tablet PC Input Panel Tutorial. Ideally, do the exercises as well.

The key items to take away from these tutorials are:

· Use your pen instead of a mouse.

· Use Input Panel on a tablet where you would have used a keyboard to enter text on a standard computer. You may use script or printing, but use upper and lower case and write using the line as a guide.

· Open Input Panel using the icon on the taskbar. Close it when you’re not using it if you need more screen space.

· Tap once in the spot you want the type to appear before you start writing in Input Panel.

· To enter text using your handwriting, tap the Writing Pad tab on the lower left of Input Panel. Correct the text using the onscreen keys to the right of the writing area for cursor control and deleting mistakes.

· If you get frustrated with the writing pad, switch to the Input Panel keyboard by tapping the Keyboard tab on the lower left of Input Panel.

That’s enough to give you rudimentary text input with the pen. If you just can’t wait to find out more, go ahead and skip to Chapter 2 and come back here once you’re an Input Panel expert. If you want to put off using Input Panel entirely for a while and you have a USB keyboard, simply plug it into tablet and use a standard keyboard instead. xe "tutorials"
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Figure 1-3.   The Tablet PC Tutorials are worth going through at least once
The Tablet PC Input Panel is primarily a tool for entering text when a standard keyboard is not convenient or available. xe "Input Panel"This, of course, is something you must do all the time on a tablet, so Input Panel is a large part of your tablet experience. Ideally, you could use your pen and enter information directly into any document by putting the pen to the screen where you want the information to go and starting to write. In fact, this was the original plan for pen input and may be possible as more programs appear specifically designed for the tablet. The problem is that the majority of programs you use on your tablet today were designed for keyboard input, not for pen input. The first attempts at making keyboard-centric programs accept pen input directly worked, but the process was confusing for the user. The solution was to create a system in which the users could place the cursor where they wanted to write but actually write the information with a pen in a separate input area, much like the writing area of a Palm or Pocket PC. The computer would respond as if the user had placed the cursor with a mouse and started typing on a keyboard. That system is Input Panel.
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Chapter 2: 
Learning to Write 
on Your Tablet PC

Input Panel Options

While Input Panel has its limitations, xe "Input Panel:reasons to use"it will work with every Microsoft Windows application that runs on the tablet, even command-line applications. Part of your success in using Input Panel is knowing which part of Input Panel to use for which situation and when not to use it at all. xe "input, options for"Each input option has its advantages, disadvantages, and best uses.

· On-Screen Keyboard   The on-screen keyboard is a xe "on-screen keyboard"

xe "keyboard, on-screen"tedious way to enter more than a short sentence worth of text. Since it actually is a keyboard, however, there are no handwriting recognition errors and symbols such as @ are easily accessible. The on-screen keyboard is best for entering passwords, Web addresses that are not real words, uncommon technical terms not found in the tablet’s dictionary, and small on- screen text corrections.

· Writing Pad   The writing pad is best for xe "writing pad"

xe "Input Panel:writing pad"entering up to four or five sentences of normal English. Exactly how many sentences varies with how well the handwriting recognizer understands your handwriting and the language you use, as well as your tolerance for going back and correcting mistakes. The writing pad works well for short e-mail messages, Web addresses based on real words, minor document editing, and many general Windows tasks, such as naming new folders.

· Write Anywhere   Write Anywhere is a xe "Write Anywhere feature"

xe "Input Panel:Write Anywhere feature"variation on the writing pad that provides more writing space and a transparent writing surface. The word recognition error rate is the same as with Input Panel but it is more comfortable to enter a paragraph or more of text with handwriting. It’s somewhat harder to use your pen in place of a mouse while Write Anywhere is activated.

· Speech Input   Speech input is done through xe "speech input"

xe "Input Panel:speech input"Input Panel and is good for text input of many paragraphs. It’s fast, but it requires concentration to avoid “ums” and “uhs” and time to go back and correct mistakes. Speech input frees you from typing or writing as you think, which can be helpful for getting your thoughts down if you don’t type quickly, and it can be useful for transcribing documents if you’re not a fast typist.

· Standard Keyboard   A standard keyboard is still the best tool for entering text quickly and accurately. To use your tablet fully, some kind of external keyboard is required at least some of the time.
Viewing and Using the Input Panel Keyboard
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Most of the time you’re xe "Input Panel:entering text with"using your tablet you’ll want Input Panel hidden because it takes up quite a bit of screen space. xe "hiding/viewing Input Panel"

xe "viewing/hiding Input Panel"To see Input Panel, tap the Tablet PC Input Panel button xe "taskbars:Input Panel button"

xe "Input Panel button"on your taskbar. By default, Input Panel will appear at the bottom of your screen in keyboard mode as shown in Figure 2-1. To make Input Panel disappear, either tap the Input Panel button again or tap the close button in the upper right of the Input Panel window. When Input Panel is visible, you can enter text by tapping once on the screen to place your cursor and then tapping in your text using the on-screen keyboard.
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Figure 2-1.   Input Panel’s primary function is to input text when a standard keyboard is not accessible.

[image: image99.bmp]Here’s an example for entering text using the Input Panel keyboard. xe "text:entering with Input Panel. See Input Panel"Open Microsoft Internet Explorer, and then open Input Panel. Tap once in the Address box of Internet Explorer to select the text. Using the Input Panel keyboard, enter the URL www.microsoft.com/tabletpc/ using the Input Panel keyboard as shown in Figure 2-2. Tap the Enter key on the Input Panel keyboard when you are finished. If you’re connected to the Internet, the Tablet PC home page should appear. Incidentally, this page is a great source of information, tips, and downloads for your Tablet PC. If the page doesn’t load, try entering the full URL of http://www.microsoft.com/windowsx/tabletpc/
Remember that using the Input Panel keyboard is just like using a standard keyboard in that you must specify where you want the text to go before you start typing. The most common mistake people make using Input Panel the first few times is forgetting to tap once on the screen to place the cursor.

If you make a mistake as you type, you can Backspace, Delete, and even use modifier keys, such as Ctrl+C for copy, just as you would with a standard keyboard. xe "Shift key, using with Input Panel"

xe "Ctrl key, using with Input Panel"

xe "modifier keys, using with Input Panel"To use a modifier key, such as the Shift or Ctrl key, simply tap the modifier first and then tap the modified key. To make entering e-mail addresses a bit easier, the Input Panel keyboard has a dedicated @ key as well. 
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Figure 2-2.   Use the Input Panel keyboard to enter text as well as keyboard commands such as Enter, Tab, and Delete.

The Input Panel keyboard has a few shortcomings. It lacks a number pad, and it’s fairly easy to tap the wrong key inadvertently if the keys are resized too small. If you use an alternative keyboard layout, such as a French or German keyboard, the keys on Input Panel do not appear to change even though they actually create different characters when you type them. If any of these are a problem for you, use the on- screen keyboard built into every version of Windows XP. The on-screen keyboard is found in the Accessibility folder in the Accessories folder in the Start menu. If you use this keyboard often, you can drag the icon to your Quick Launch bar or to your Start menu for easy access. Figure 2-3 shows the Windows on-screen keyboard and the Input Panel keyboard. xe "Input Panel:entering text with"
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Figure 2-3.   Use the Windows on-screen keyboard (upper) for alternative keyboard layouts, such as this French layout, and for access to a number pad.
Using the Input Panel’s Writing Pad

The Input Panel writing pad xe "writing pad"

xe "Input Panel:writing pad"

xe "handwriting recognition:See also writing pad"accomplishes exactly the same thing as the on-screen keyboard, entering text when a standard keyboard is not available, but it uses your handwriting as the source for the text. The system for handwriting recognition used on your tablet is the culmination of years of research and is quite arguably the best in the business, but it will make mistakes. The key to satisfaction with the Input Panel writing pad is understanding how to minimize those mistakes, correct them easily where they occur, and use alternative means of text input where the writing pad doesn’t meet your needs.
Entering Text with Handwriting

To switch to the xe "writing pad:entering text with handwriting"

xe "Input Panel:writing pad:entering text with handwriting"writing pad for text input, tap the Writing Pad tab on the bottom of Input Panel. To test out the writing pad, you will need somewhere for the text to go. The best choice is a word processor, such as Microsoft Word, or a text editor such as Notepad.

Figure 2-4 shows an Input Panel writing example and the resulting text. As promised in the sidebar, “My Handwriting: I promise honesty,” the text shown in Notepad is the actual text as recognized by the tablet.
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Figure 2-4.   As with the Input Panel keyboard, place the cursor where you want the text to appear before writing on the Input Panel writing pad.

Take a close look at the word “Writing” as I have written it in Figure 2-4. My “t” has an extra line where I dragged my pen up to cross it rather than lifting the pen and my “g” looks more like a “y” because I did not close it off. Also, my “d” in “Pad” resembles a cursive “l” or perhaps an “el.” The tablet correctly interpreted what I wrote, despite these shortcomings, because it doesn’t simply interpret single letters, it looks at the individual letters and the whole word. Even though my “g” looks like a “y,” the recognition system correctly understood “Writing” because “Writiny” is not a word. The system of identifying both letters and entire words can work for or against you depending on how you write. Table 2-1 provides some general rules, examples of how the errors might look on the screen, and the results on handwriting recognition. Some of the items in the table may seem especially dramatic, but the truth is that most took two or three attempts to get an error at all.

Table 2-1   Some basic rules to greatly reduce recognition errors.
	Writing Pad Input
	Resulting Text
	Notes
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	TABLE+ Tablet
	Upper and lowercase work better than all capitals. xe "handwriting recognition:guidelines for reducing errors"

xe "writing pad:guidelines for reducing errors"
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	Tablet Fillet
	Cursive works better than printing if your cursive is fairly neat and even.
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	Watch yours pacing
	Leave space between words.
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	On the line forth.live
	Write on the line.
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	Total/ t.our,’de
	Use a normal height to width ratio, particularly when printing
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The Send Button

When you first try xe "Send button (writing pad)"out the writing pad, you’ll probably find yourself waiting at the end of each line for the text to disappear from the pad and appear in your document. This is not because the handwriting recognizer is slow. In fact, the recognizer has the word interpreted in a fraction of a second. The speed at which the words disappear off the pad is determined by the Input Panel options. If you find yourself waiting for Input Panel to empty, tap the Send button sitting just below the writing line and your wait will be over.xe "writing pad:entering text with handwriting"

xe "Input Panel:writing pad:entering text with handwriting"
Correcting Recognition Errors

By default, a few xe "Input Panel:writing pad:correcting handwriting recognition errors"keyboard keys appear beside the writing pad. This is the quick keys pad; it’s helpful for putting returns and tabs into a document along with the writing pad text. The quick keys pad also provides arrow, Backspace, Delete, and Space keys for making simple corrections. To correct text, either tap next to the mistake to place the cursor and use the Backspace or Delete keys or select the mistake with the pen and rewrite it using the writing pad or the Input Panel keyboard. Normally the handwriting recognition looks for whole words; however, when you enter letters one at a time on the writing pad to correct text, the system knows you are correcting the word and won’t try to make new words. It’s even “smart” enough that if you add a suffix to a word, such as adding “ing” to “fly,” it usually understands you are adding to a word rather than inserting a new one.
Fixing Symbols and Punctuation
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xe "symbols, entering in writing pad"

xe "special characters:entering in writing pad"

xe "handwriting recognition:symbols and punctuation"

xe "writing pad:symbols and punctuation"

xe "punctuation, entering in writing pad"Entering symbols such as _ and + in the writing pad can be very difficult. These symbols usually appear as E and t. The numbers 1 and 0 are also a challenge as they usually come out as the letters l and O. Tapping the Symbols Pad button (&) on the Input Panel title bar xe "Symbols Pad button (Input Panel)"

xe "Input Panel:Symbols Pad button"opens a palette of commonly used symbols as shown in Figure 2-5. The symbols pad closes automatically after you tap a single key. You may drag the symbols pad off the title bar and keep it available as a floating palette. This is xe "tearing off the palette"called tearing off the palette. It will then remain visible until you close it or hide Input Panel.
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Figure 2-5.   Entering common symbols from the symbols pad saves a lot of frustration.

Using Text Preview

The text preview pane lets you view xe "previewing recognition:writing pad"

xe "handwriting recognition:previewing with Text Preview"

xe "writing pad:previewing text recognition"and edit text after it’s converted from handwriting but before it’s inserted into a document. To view the text preview pane, tap the Tools menu on Input Panel and select Text Preview. The text preview pane will appear above Input Panel. Now when you write on the writing pad, the interpreted text appears in the text preview pane rather than in a Windows application. To send the text from the text preview pane into an application, tap once in the application where you want the text to go and then tap the Send Text button in the text preview pane. Figure 2-6 shows this process.
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Figure 2-6.   The text preview pane lets you see and, if necessary, edit the recognized text before it goes out to the Windows application.

Alternate Words List

While the text is in the text preview pane, xe "alternate words list (writing panel)"

xe "words, alternate (writing panel)"

xe "handwriting recognition:alternate words list"

xe "writing pad:alternate words list"you have an additional tool for text correction. The handwriting recognition system inserts its best guess for your word in the text preview pane. It also keeps on file up to ten more words that are strong alternate possibilities. Single-tap or double-tap any word in the text preview pane, and a small green carat appears on the upper left of the word. Tap the carat, and a list of alternate words appears. In Figure 2-8, the text “Alternate Words List” was recognized as “Alternate Wards List,” but the correct word was on the list of alternates. xe "capitalization, recognizing"

xe "handwriting recognition:capitalization"Words capitalized incorrectly is one of the most common handwriting recognition problems in Input Panel. You’ll notice that the first alternate in the list will always be the same word, but with opposite capitalization. The alternate words list functions like most spelling checkers. Select the correct word from the list, and it replaces the original. A small version of the original ink also appears in case you can’t remember what you wrote. Even when the words chosen by the system seem way off, the correct words may still be on the alternates list. I had “tomorrow evening” come up as “terrarium every” once, but the correct word was available for both of them.
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Figure 2-7.   While text is still in the text preview pane, you can substitute from a list of alternates as well as perform drag and drop edits.

You may select many words at once or parts of a word to correct. Occasionally this allows you to correct two words at once but usually not, and the original ink does not appear with groups of words. Options to delete or rewrite the word also appear, but these are a bit superfluous. If you want to rewrite a word in the text preview pane, select it by double-tapping and write a new word on the writing pad. The new word will replace the old one. The text preview pane can hold many paragraphs’ worth of text, and you can drag and drop to rearrange words.

Writing Pad Gestures
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There are four gestures xe "gestures:writing pad"

xe "writing pad:gestures"that provide keystroke shortcuts while you are using the writing pad. These gestures are pen movements that will not be transformed into text. Instead, Input Panel will behave as if you tapped a button on the quick keys pad. Gestures work only on a blank writing pad, so you must wait until it is free of ink. You may use the gestures to control the cursor in a document or in the text preview pane. Gestures are sent immediately, so the ink will not stay in the Input Panel window for a moment before disappearing. If it does stay for a moment, then the gesture was misinterpreted as text.

Keystroke Gestures

The key to executing a good gesture is to do it fast and with authority. xe "keystroke gestures (writing pad)"

xe "Space key, gesture for"

xe "Enter key, gesture for"

xe "Backspace key, gesture for"

xe "Tab key, gesture for"

xe "gestures:writing pad:keystroke gestures"

xe "writing pad:gesture:keystroke gestures" Timid gestures just don’t work as well. Table 2-2 shows both a generic version of the gesture and an example of what this might look like on the writing pad. Notice how the Space and Backspace gestures use most of the pad area. This is not required, but it seems to give more consistent results.

Table 2-2   These four gestures allow quick keystrokes without using the quick keys pad or the Input Panel keyboard.
	To get this keystroke
	Draw this gesture
	Example

	Backspace
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	Space
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	Enter
	[image: image20.png]



	[image: image21.png]Tablet PC Input Panel






	Tab
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Scratch-Out Gesture

In contrast to the keystroke gestures, xe "gestures:scratch-out gesture"

xe "writing pad:gesture:scratch-out gesture"

xe "scratch-out gesture"the scratch-out gesture requires that you have ink on the writing pad. Scratch-out allows you to erase ink you just wrote before it leaves the writing pad. A scratch-out must be at least 2.5 lines, shaped like a flat Z, that intersect the ink you want to erase. Scratch-out works more consistently if you don’t try to cover the ink you want to erase with the scratch-out mark. Instead, go back and forth over the same line in a very horizontal motion. Whatever ink intersects that line should disappear. Both examples in Table 2-3 can result in a scratch-out, but the upper one will produce more reliable results.

Table 2-3   Make your scratch-out back and forth over the same spot instead of trying to cover the entire item.
	Scratch Out Gesture
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	Better Scratch Out
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	Worse Scratch Out
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More Writing Pad Tips

Here are a few more tips to help you get the most out of the writing pad: xe "handwriting recognition:guidelines for reducing errors"

xe "writing pad:guidelines for reducing errors"

xe "size:handwriting, recognition and"
· Because the ratio of height to width of letters is important, adjust the height of the Input Panel window so that you can write comfortably while still having your capital letters use about 7/8 of the writing area.

· If the handwriting recognizer keeps interpreting single words as many small words or individual letters, your letters are too far apart. Either make them closer together or use cursive handwriting.

· The longer the writing pad area relative to its height, the more words you can fit in before you run out of space.
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· The smaller you write, the closer together your letters should be. It’s even okay if they occasionally overlap. This is especially important if you reconfigure your writing pad to show two lines instead of one line.

· If you use the writing pad to input full sentences on a regular basis, try decreasing the time before text automatically inserts or try a two-line writing pad. Either option allows you to write continuously without waiting for ink to disappear. See “Setting Input Panel Options” later in the chapter for more information on a two- line writing pad.

· To input long sections of text to older programs, fill the text preview pane with an entire message and then correct it all at once.

· If the system keeps misunderstanding a word, spell it out one letter at a time and then add it to the dictionary.xe "spelling words:adding words to dictionary"
· For better results when correcting single letters, use cursive to create lowercase letters and print for uppercase. The one exception is capital I.

· Use a cursive for capital I and draw the upper hook and lower horizontal of a 1 (one) to distinguish them from l (el).
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· To create an ampersand (&), you can write the common abbreviation of “E” with a vertical line through it.
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· Write the http:// prefix for Web addresses.

· The writing pad often adds a space on the end of each word. This can cause a problem with some filenames, login names, and passwords. If you’re having trouble with something that appears to be correct, try pressing Backspace to remove the last character after text appears. Capitalization errors can cause similar problems.
xe "handwriting recognition:guidelines for reducing errors"

xe "writing pad:guidelines for reducing errors"

xe "Input Panel:writing pad:correcting handwriting recognition errors"
Using the Input Panel’s Write Anywhere

The Input Panel writing pad works well for a few sentences, xe "Write Anywhere feature"

xe "Input Panel:Write Anywhere feature"but writing on the same line over and over is not how we really handwrite messages. The Write Anywhere feature essentially turns most of the tablet screen into a transparent writing pad. This is a powerful feature, but it can be confusing because it appears that you’re writing directly on a document, as you can with Windows Journal and Microsoft Office XP with the Office XP Pack for Tablet PC. You’re not. Write Anywhere is a version of the Input Panel writing pad and is still a method for text entry when the keyboard is not accessible or convenient.
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Turning on Write Anywhere

To use Write Anywhere, first open the document in which you want to place text. Next open Input Panel, and tap the xe "Input Panel:Write Anywhere button"

xe "Write Anywhere feature:turning on"Write Anywhere button on the title bar. The Write Anywhere button has an image of a pen on it. If the Write Anywhere button is not visible, tap the Tools menu on Input Panel and tap Options to display the Options dialog box. On the Write Anywhere tab, check the Show The Turn On Write Anywhere Button On The Title Bar check box and tap OK.

When you tap the Write Anywhere button, a Write Anywhere information dialog box appears. Tap OK, and the Write Anywhere boundaries appear on the screen as shown in Figure 2-8, where Write Anywhere is open on top of a new message in Microsoft Outlook Express.

There are three important items to note in this figure:

· The writing area does not extend to the edges of the screen. Only handwriting drawn within the bounded area is translated to text. Pen actions outside the area are interpreted as mouse commands. This division keeps menus, the taskbar, and open and close boxes free of the writing area for easy access. You can still control the mouse under the transparent writing area, but it’s a bit trickier.

· Input Panel should be docked and hidden at the bottom of the screen. This is not required, but it’s a good way to start out when using Write Anywhere. If the writing pad of Input Panel is visible under the Write Anywhere transparency and you write over the actual Input Panel writing pad, the writing pad overrides Write Anywhere. The result can be confusing and is best avoided until you get comfortable with Write Anywhere. Either hiding or docking Input Panel will avoid the problem. I prefer to do both.

· The cursor is ready at the point in the document where the text should go. It doesn’t matter where on the writing area you write, the text will insert at the cursor in the order you wrote it. To place the cursor in a different position, tap that point on the screen. If you are placing the cursor somewhere under the writing area transparency, it should be a firm tap you hold for a moment so that the system knows it’s a tap (mouse action) and not a period (handwriting).
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Figure 2-8.  To turn on Write Anywhere, first open a document, open Input Panel, and then tap the Write Anywhere button. It helps if you hide or dock Input Panel while using Write Anywhere.
Using Write Anywhere

Once the writing area transparency is xe "Write Anywhere feature:entering text"

xe "text:entering with Write Anywhere. See Write Anywhere feature"open and the cursor is in place, you can begin writing. As shown in Figure 2-9, wherever you start writing, a black line appears to help you write horizontally across the screen. You do not need to write on the line, but the recognition is better if your handwriting does not wander all over the screen. As with the writing pad on Input Panel, there’s an adjustable delay before the ink disappears and the text appears in the document.
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Figure 2-9.   Tap once to place the cursor where you want text to go, and then start writing anywhere on the writing area transparency.
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When you’re using the Input Panel writing pad, you must specify each Enter, extra Space, and Tab. If you do not, the system will put all your text together no matter how you organize it on the screen. You can send these commands using the same gestures as with the writing pad, but the entire writing area transparency must be clear of ink. Because the ink tends to persist longer in Write Anywhere, this isn’t always convenient. Another method is to open the quick keys pad from the Input Panel title bar while Write Anywhere is still open. You can tap an Enter, Tab, or other key on the quick keys pad without waiting for the ink to disappear; however, as soon as you tap a key all the ink currently in the writing area will be immediately converted to text. Figure 2-10 and Figure 2-11 show how the system would ignore text organization (new lines, tabs, and so on) and how it could be corrected.
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Figure 2-10.   Write Anywhere allows you to write freely over the screen, but it does not interpret the organization of your text. Figure 2-11 shows how this text is interpreted.

Selecting an entire paragraph xe "selecting:Write Anywhere paragraphs"with Write Anywhere open is simple if you start the selection on the edge of the screen, outside the writing area. Press down with the pen at the beginning of the selection, and drag the pen over the text you want selected. To select text underneath the transparency, press and hold on a point under the writing transparency. The transparency temporarily vanishes and remains absent as long as you keep holding. Without lifting the pen, you may now drag the pen over the text you want selected. As soon as you lift the pen the transparency reappears, but the text remains selected. You must either disable the Press And Hold For Right- Click option or set a long pause before the shortcut menu appears for this to work; otherwise, you’ll get a shortcut menu instead of a selection. If you use the Press And Hold For Right-Click option, it’s usually easier to close Write Anywhere for a moment, select the text you want, open Write Anywhere again, and continue. Because the writing transparency opens and closes instantly, this hardly disturbs your work.
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Figure 2-11.   You may edit and correct text by using gestures, such as the Enter gesture shown here, by tapping keys on the quick key pad, or even by switching to the Input Panel on-screen keyboard while Write Anywhere is open.

When you reach the bottom of the writing area, you may continue writing at the top in the empty space, as shown in Figure 2-12. The text will enter your document in the same order you wrote it, regardless of where you wrote it or what is below the transparency. The text at the top of Figure 2-12 was written last and will appear at the end of the sentence.
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Figure 2-12.   Text will be entered into your document in the same order you wrote it, regardless of where you wrote it or what is below the transparency.

Write Anywhere is a tool you will probably either love or hate. If you use Write Anywhere regularly, here are a few tips to keep things running smoothly:

· Hide or dock Input Panel while Write Anywhere is open. If your pen enters the Input Panel window, it will interrupt your writing.

· Tear off the quick keys pad from Input Panel so that it is available as you write. Be careful not to write on top of the quick keys pad, as the keys will respond and interrupt your writing. See “Setting Input Panel Options” later in this chapter for information on how to add the Quick Keys button on the Input Panel title bar, which allows you to tear off the quick keys pad.

· If the writing transparency is free of ink, a gesture is even faster than tapping a key on the quick keys pad.

· Remember to tap or gesture an Enter command at the end of each paragraph.

· Adjust the speed of the automatic insert so that it converts the ink as fast as possible without disturbing your writing. Write Anywhere is a drag if you must wait for the ink to disappear.

· Closing the Write Anywhere transparency will immediately convert the ink into text and send it to the cursor, similar to the Send button on the writing pad.

· Switching to a different program while there is still ink in Write Anywhere will cause that ink to appear in the new program or be lost entirely.xe "Write Anywhere feature:entering text"

xe "Write Anywhere feature"

xe "Input Panel:Write Anywhere feature"
Send as Text vs. Send as Ink

As flexible andxe "ink:when not to convert to text"

xe "Input Panel:when not to convert ink to text"

xe "text:when not to convert ink to"

xe "Send As Ink option (writing pad)"

xe "Send As Text option (writing pad)"

xe "writing pad:Send As Text, Send As Ink options" useful as Input Panel is, we have been looking at it as a bridge between old and new technology. It is a method of translating from a medium humans understand, handwriting or speech, to a medium the computer can manipulate, standardized characters. Once the ink vanishes off Input Panel and converts it to text, it is lost.

Input Panel can send the actual pen strokes, or ink, from the writing pad, as well as the list of possible meanings, to the application. Some applications can’t accept this kind of data, but many can. Exactly how the ink will appear in the document and to what extent you can edit it varies; in some the pen strokes and the alternate word list are available, and in others the ink is converted into a static, un- editable image.

To send ink off the writing pad as ink, place the cursor in the document where you want the ink to appear and then tap the down arrow to the right of the Send button on Input Panel. If the Send As Ink option is available, the application you chose will accept the ink. Select Send As Ink, and whatever you write will appear in the document as ink. Figure 2-13 shows an example with Word 2002. xe "ink:when not to convert to text"

xe "Input Panel:when not to convert ink to text"

xe "text:when not to convert ink to"

xe "Send As Ink option (writing pad)"

xe "Send As Text option (writing pad)"

xe "writing pad:Send As Text, Send As Ink options"
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Figure 2-13.   Some applications will accept the pen strokes off the writing pad as ink as well as text.
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Chapter 3: 
Taking Notes with Journal

Getting Started with Journal

Windows Journal xe "Windows Journal"is the “killer application” on your new tablet. It’s an excellent example of good software design: simple and intuitive enough to start using with minimum instruction, yet packed with powerful features awaiting your discovery. On the surface, Windows Journal works like a pad of paper. To take notes, simply place your pen on the screen and start writing. In fact, a great deal of design effort went into making Journal behave as much like real paper as possible. If you start thinking about Journal as a pad of paper, you’ll be off to a great start.

In this chapter, you’ll discover some of the capabilities of Journal. For example, you’ll learn how your pen can write in several colors, work as a highlighter, and how it can erase. You’ll learn how to add and remove space in your notes, cut and paste your handwriting, and format your handwriting into bold and italics. You’ll also learn how to search your handwritten notes for specific words and how to import documents from programs like Microsoft Word and mark them up with pen and highlighter as easily as if they had been printed out. These latent features are the real power of Journal. You can use Journal at whatever level of sophistication meets your needs in a given situation.
When you use Tablet PC Input Panel and Write Anywhere, you write on the tablet to add typed text into a Windows application document, such as a Microsoft Word document. When you use Journal, write on the tablet to add your handwritten notes in that Journal document, called a note. You can save the handwritten note and use it only in Journal, you can paste the note’s handwritten “ink” into another application, or you can convert the ink to text and insert it into another application. 

Use Journal just as you would any pad of paper and pen, such as when taking notes during a student presentation.

Just Start Writing

The best way to get going with Journal is to take a few moments to just start writing and exploring the user interface. Figure 3-1 shows the default Journal page. xe "Windows Journal:major components"Try out the different pens, highlighters, and erasers in the Pen toolbar to get a feel for them. To switch between them, tap the down arrow to the right of the tool and select the particular pen, highlighter, or eraser you want. Most people have a definite “Oooh- Aaah” reaction the first time they use the chisel tip pen. It makes everyone’s handwriting look better, even mine.
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Figure 3-1.   These are the major components of Journal.

As shown in the figure, the major components of Journal are as follows:

· Note body   This is your digital paper. Write or draw here to your heart’s content. When you fill a page, tap the New Page button in the lower right corner to start a new page.

· Note title   When you first save the note, the default filename will be the note title converted to text, although you can change the name to anything you want before you save. When you list all your notes, you will see the actual ink of this title as well as the filename. See Saving and Opening Notes later in this chapter for more information.

· File buttons   These are the familiar buttons for new and save, as well as buttons for importing documents into Journal and searching notes, discussed in Chapter 5. The button with the folder icon opens a list of recent notes. The note list can be used to open notes, but it is a little different than a standard open function. See Saving and Opening Notes later in this chapter for more information.

· Editing buttons   Cut, copy, paste, undo, and redo buttons are similar to what you find in Word. There is also a view setting allowing you to zoom in and out on a note.

· Pen tools   These tools control the behavior of your pen and are described in Using Pens and Highlighters and Using Erasers later in this chapter. Pen tools include Pen, Highlighter, Eraser, Selection Tool, Insert/Remove Space, and Flag.

· New Page, Next, and Previous   The double arrow buttons will scroll up or down one page. If you are on the last page of the note and scroll down one page, a new blank page is appended to the note.
Using Pens and Highlighters

The default settings xe "Windows Journal:pens and highlighters"

xe "highlighters, Windows Journal"

xe "pens, Windows Journal"provide five pens of various colors, tip types, and tip sizes. Once you have seen what these pens can do, you can customize the pen palette as you need to for different uses. Do you need a very fine red point for editing documents? An extra fine black point for detailed drawing? A four mm purple chisel marker for calligraphy? Open the Pen And Highlighter Settings dialog box by selecting Pen Settings from the bottom of the pen menu, as shown in Figure 3-2.
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Figure 3-2.   Try out different pen types and build a custom palette that meets your needs.

In the Pen And Highlighter Settings dialog box, shown in Figure 3-3, select the pen you want to change. Next select the color, thickness, and tip style you want for the new pen. xe "point tip pen (Windows Journal)"

xe "chisel pen (Windows Journal)"A point tip is similar to a ballpoint or rollerball pen. A chisel is similar to a fountain pen. Try some wild colors and pen sizes while you’re at it.
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Figure 3-3.   Use the Pen And Highlighter Settings dialog box to modify your pen settings.
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Highlighters are selected and used just like pens, except that the ink is partially transparent and the tips are wider. The five highlighter colors, thicknesses, and tips can be customized as well. Highlighter colors will also mix, so if you highlight an area with yellow and then again with blue, wherever the colors overlap the highlight will be green. Going over an area with the same color several times, however, will not make it any darker.
Pressure sensitivity

Checking the xe "pen:pressure sensitivity"

xe "pressure sensitivity, pen"Pressure Sensitivity check box in the Pen And Highlighter Settings dialog box creates a pen or highlighter that responds to pressure—the harder you press, the wider the ink. The feature really shows with chisel tip pens and markers, as you can see in Figure 
3-4. Unfortunately, not all tablet digitizer systems support pressure sensitivity. The pressure sensitivity option will appear whether or not your tablet hardware supports it. If it pressure sensitivity doesn’t seem to work, it’s probably not available on your tablet.
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Figure 3-4.   Here’s an example of what can be done with a pressure-sensitive chisel tip

Using Erasers
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The eraser tool is xe "erasing ink:Windows Journal erasers"

xe "Windows Journal:erasers"used just like a pen: select a small, medium, or large eraser tip and press down as you erase. The eraser cursor is square, but if you cut an ink stroke with the eraser, the trimmed ends will appear rounded or chiseled depending on the pen used to draw the stroke. Looking closely at the left-hand image in Figure 3-5 you can see how the end of the line is rounded even though it was cut with a square eraser. The stroke eraser, the fourth eraser type, is a “smart eraser” and works differently from the other three. The right-hand image shown in Figure 3-5 was tapped in exactly the same spot as the left-hand image but it was done using the stroke eraser. Because I drew the circle of the bug’s head as a single pen stroke, the stroke eraser removed the entire thing. The stroke eraser allows you to remove large areas of ink quickly, and you can selectively remove ink strokes that cross other ink strokes. In the right- hand image of Figure 3-5, the antennae remained intact even though they crossed over the circle of the bug’s head. Once you get used to it, you’ll probably use the stroke eraser most of the time.
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Figure 3-5.   A normal eraser is used on the left and a stroke eraser is used on the right. The stroke eraser removes entire ink strokes at once.

Some tablet pens have a feature that you almost have to see to believe. xe "pen:physical eraser on top"These pens have a plastic “eraser” on the top. This eraser is really a button. If you flip the pen over and press down with the eraser as you move it, Journal automatically switches to the eraser tool! When you flip it back, the pen will revert to whatever tool you had selected previously. You can’t get much more intuitive than that! Some pens have a two-position button on the pen shaft that provides the normal right-tap when you push it one way and does a quick switch to the eraser when you move it the other way. Some pens even have both quick eraser buttons. Journal also supports multiple undos, providing another great way to remove recent mistakes.
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Scratch Out Gesture

Journal also supports the xe "gestures:scratch-out gesture"

xe "Windows Journal:scratch-out gesture"

xe "scratch-out gesture"scratch out gesture used in Tablet PC Input Panel and Write Anywhere. The gesture is a bit harder to get right in Journal because the system must now decide if you are scratching out or simply shading in a picture. As with the other scratch out gestures, you do not need to cover the entire object for scratch out to remove the entire stroke. The scratch out in Figure 3-6 would remove the entire word “Out,” similar to crossing the letters with the stroke eraser. You must, however, make the gesture aggressively, with horizontal strokes, and move back and forth at least two and one half times. The availability of the eraser, especially the stroke eraser, somewhat obviates the need for scratch out in Journal.
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Figure 3-6.   Journal supports the scratch out gesture.

Flags

Flags are a very simple but powerful feature. xe "flags, Windows Journal"

xe "Windows Journal:flags"The Flag tool places a flag graphic in your document wherever you tap. This is a great way to mark a point in your document so you can easily find it later. When you review a list of notes, you’ll see at a glance which ones contain flags. When you open a note, the Find command, lets you quickly find all the flags in the note. There are five flag colors, so you can use different ones to represent different types of items. You cannot, however, limit the search to flags of a particular color. Each flag is simply a graphic, and can be moved around or resized however you wish.
Changing the View

Journal lets you xe "Windows Journal:page view, changing"

xe "zooming in/out, Windows Journal"zoom in and out on the page, a feature that leaves traditional paper in the dust. This is great way to touch up a hand-drawn picture or do some precise erasing. There are three ways to zoom in and out: select a new zoom setting from the Standard toolbar, select a new zoom setting from the View menu, or open and use the View toolbar, as shown in Figure 3-7. The View toolbar also gives you the Pan tool, whose icon is a small hand, which allows you to slide the paper around on the screen while you are zoomed in.
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Figure 3-7.   Changing the view.

Zooming in can create problems if you don’t realize how it works. By default, new notes are shown with the paper sized to fit the available screen. This gives you the most screen area to write on, but it means your handwriting may end up very large or very small depending on the size and settings of your screen. If you write at your normal writing size with the zoom set at 50%, 100%, or 200%, the actual ink strokes will get progressively smaller. The pen will appear thicker when zoomed in, as well, since the width of the tip is a set number of millimeters. Figure 3-8 shows this effect, where the word written the same size on the screen will appear as three different sizes on the page. This is not a big deal if you never print your notes, but if you do print them the results can be somewhat unexpected.
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Figure 3-8.   Ink drawn at different zoom settings will appear different sizes relative to the page.
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Saving and Opening Notes

As mentioned earlier, xe "Windows Journal:managing notes"

xe "saving:Windows Journal notes"

xe "opening:Windows Journal notes"

xe "notes. See Windows Journal"the handwritten note title will be converted to text and set as the default name for your note. If there’s no title, the first recognizable text appears as the default filename. If the default text is what you want as the filename, tap the Save button and the note will be saved. If the text is incorrect, you will need to correct it using Input Panel. The filename need not match the note title, but it reduces confusion if you can keep them the same. xe "My Notes folder"By default, your notes are saved in a new My Notes folder in your My Documents folder.
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Note List

You can open a note by double-tapping the actual file in your My Notes folder, but using the note list in Journal provides a lot more options. Tapping the View Recent Notes toolbar button in Journal opens the note list pane shown in Figure 3-9. The note list shows the ink contained in the title area of the note as well as the filename, so you can find a note either way. If there’s no ink in the note title area, that column is left blank. The note list pane is also a kind of notes browser. Whatever note you select in the note list is opened in the window below, and tapping the Previous or Next buttons or pressing the Up or Down arrow key will open the next note in the list.
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Figure 3-9.   The note list pane shows you the note title in ink as well as the filename.

You can also organize the note list view by folder, creation date, modification date, or show only the notes containing flags. Figure 3-10 shows notes organized by creation date, a handy feature if you can’t remember what you called that note you wrote last Thursday. Tapping any column title will sort the notes by that column in descending order as well. Tapping a second time will sort them in ascending order. A red flag to the left of the note title appears if there are any flags in the document, regardless of their color. The note list is further customizable by right-tapping on any column heading. The resulting shortcut menu lets you turn on several more fields. For example, the Flags column showing the number of flags in each document, as seen in Figure 3-10, is not on by default and was added using this shortcut menu.
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Figure 3-10.   Note list offers organizational tools to help you find your notes.xe "saving:Windows Journal notes"

xe "opening:Windows Journal notes"
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Deleting Notes

Since many notes xe "deleting:Windows Journal notes"are only needed for a short time, deletion of unneeded notes is made easier by a Delete Note option on the File menu. The Delete Note command works on the note you have open or the note you have selected in the note list. This is a very handy command when you are cleaning out old notes without the use of a keyboard and don’t have a hardware button for delete.
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Adding Pages

Once you fill a page, xe "Windows Journal:adding pages"

xe "pages, adding to Windows Journal"

xe "adding pages to Windows Journal"

xe "inserting:new Windows Journal pages"

xe "new pages to Windows Journal, adding"tap the New Page/Next button in the lower right of the Journal window. If you’re in the middle of a multi-page note, this button scrolls the view down one page. If you’re on the last page of the note, this button adds a new page to the end of the note. You can also insert a page before the page you are viewing by selecting New Page from the Insert menu. Use this feature if you want to add a cover page before sharing a note.

Inserting and Removing Space on the Page
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Often when writing a note, xe "space, inserting to Journal page"

xe "vertical space, inserting to Journal page"

xe "inserting:vertical space on Windows Journal pages"

xe "deleting:vertical space on Journal page"especially a list, you need to add an item between two items already on the note. With traditional paper you’re out of luck, but not with Journal. To insert vertical space in between items on a note, choose the Insert/ Remove Space tool on the Pen toolbar and bring the cursor to the point in the document that you want to expand, as shown in Figure 3-11. Next drag downward to indicate how much extra space you want, and lift the pen. All the ink below the insertion point will move downward on the page, allowing you to write in the additional space. The Insert/Remove Space tool won’t split up grouped ink, so if xe "grouping and ungrouping ink:inserting space into groups (Windows Journal)"

xe "ink:grouping (Windows Journal)"there’s ink on both sides of the insertion point it will either all move down or all stay put, depending on which side of the insertion point the majority of the ink lies. To remove space, place the Insert/Remove Space tool at the bottom of the blank space and drag upward. When you remove space, you can only remove space that’s completely free of ink. The Insert/Remove Space tool won’t delete ink.

If the ink moved down will no longer fit on the page, you’ll see the Space Tool dialog box, shown in Figure 3-12, asking if you want to increase the height of the page or move the ink below the insertion onto a new page. If you increase the height, you’ll have one page that is longer than all the others. This is only a problem if you plan to print the note, as one page will print differently. If you move the ink to a new page, all the ink below the insertion point will move to a new page, even if there’s still room for some of the ink on the current page.
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Figure 3-11.   To add vertical space, tap and drag downward with the Insert/Remove Space tool.
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Figure 3-12.   Dialog box that appears if there isn’t enough space on the page when using the Insert/Remove Space tool.

Editing Notes
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If Journal did xe "Windows Journal:editing notes"

xe "editing Windows Journal notes"nothing more than supply a digital writing pad, it would still be useful, but it’s the power to select and edit ink that makes Journal really shine. xe "Windows Journal:editing notes:selecting and moving ink"

xe "editing Windows Journal notes:selecting and moving ink"

xe "selecting:Windows Journal ink"

xe "moving:Windows Journal ink"

xe "ink:Journal notes. See Windows Journal"To select ink and move it to a new location, select the Selection Tool on the Pen toolbar and circle (or lasso, as the icon might imply) the ink you want selected. As ink is added to the selection, it appears in an outline format. Once you have all the ink selected, lift your pen. The selection is bounded by a box. To move the ink, tap and drag anywhere inside the box. Tap anywhere outside the box or switch back to a pen tool to deselect and continue writing. Figure 3‑13 shows the process.
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Figure 3-13.   Selecting and moving ink.

Selecting usually works easily and intuitively, but sometimes the Selection Tool seems to select extra items you didn’t want or won’t let you select the items you do want. The key to successful editing is understanding how to select exactly the objects you want, and the key to precise selection is understanding how Journal groups the ink you put down on the page.
Selecting Ink

When you write words on a page, Journal looks at the many strokes of ink you made and groups them together based on a complex logic system. For example, take the words “ink object.” The word “ink” is actually five pen strokes: the body of the i, the dot on the i, the n, the tall part of the k, and the short part of the k. Ideally, Journal will group all these strokes together so that when I select the word they all move together, and won’t leave out the dot on the i or part of the k. When you select with the Selection Tool, if 50% of a group of strokes is contained by the lasso, the entire group is selected. If less than 50% is contained by the lasso, none of the group is selected. Table 3-1 shows examples of the Selection Tool attempting to select the word “ink” out of “ink object” and the results.

Table 3-1   Results of selecting objects.
	Ink Object
	Selected Words
	Notes
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	<none>
	The original ink strokes
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	ink
	Selecting “ink”
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	ink
	Selecting at least 50% of “ink”
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	ink
	Selecting “ink” and less than 50% of “object”
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	ink object
	Selecting “ink” and more than 50% of “object”


[image: image127.png]smarter



Grouping Ink

The grouping of ink xe "grouping and ungrouping ink"

xe "ungrouping ink. See grouping and ungrouping ink"

xe "ink:grouping (Windows Journal)"strokes is done automatically as you write. If Journal groups strokes that you want to select individually, you can ungroup the strokes. To do this, select the group containing the strokes you want ungrouped and then choose Ungroup from the Actions menu. Now all the strokes are selectable individually. You can also group strokes so that they always stay together as a single object, as you might prefer with a hand-drawn map. To group ink strokes, select all the strokes you want to group and choose Group from the Actions menu. Now all the strokes will stay together if you select them in the document. If several strokes make up a word but are not recognized as such, select the strokes and choose Group As One Word instead of Group.

Resizing Ink

Whenever xe "size:ink, resizing (Windows Journal)"

xe "resizing:Windows Journal ink"ink is selected, you can drag any handle on the selection box to resize it. Dragging a corner handle will change the height and width proportionally. Dragging a middle handle will distort the shape. When creating maps or diagrams, it’s often easier to draw them large and then select and resize them smaller to fit better on the page, as shown in Figure 3-14.
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Figure 3-14.   Select and resize ink to make room as necessary.
Clever Selecting

There are several selection shortcuts and tricks to make selection easier.

· Tap to Select   The quickest way to select a group is to choose the Selection Tool and tap anywhere on the ink you want selected. This will select the entire group. In the “ink object” example earlier in this chapter, tapping anywhere on the word “ink” selected the entire word. Tapping to select is especially useful for selecting shapes surrounding words.
· Multiple Selections   To select multiple objects, xe "multiple selection, Windows Journal"

xe "Ctrl key:multiple selection with"you can select one object, tap the Ctrl button on Input Panel (or hold the Ctrl key on a standard keyboard), and then select additional objects.

· Crescent Selections   You can make a crescent-shaped xe "crescent-shaped selections (Windows Journal)"selection that gets only the items you want and avoids the rest. Figure 3-15 shows an example.
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Figure 3-15.   Using a crescent selection to select multiple objects.

· Right-tap, Tap-and-hold, or Right-drag selection

· If you right-tap, tap-and-hold, or right-drag when you select, you will get a shortcut menu with several options for editing or formatting the selection. Formatting ink is discussed in Chapter 4.
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Select All and Select Page

Select All and Select Page xe "Select All, Select Page options (Windows Journal)"appear in the Edit menu and serve two distinct functions. Select All will select all the objects, including ink, flags, text boxes, and images, on the current page, even if they’re currently off the screen. Once the objects are selected, you can resize all the items or paste them onto a different page. Select Page selects all the items on a page, plus the background. After selecting a page, the options on the Edit menu change. Now you can Copy Page, Cut Page, or Delete Page. If you copy or cut the page, you can paste the entire page into a different note. A pasted page is always inserted before the page you are viewing.
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Cutting Ink Strokes

You cannot select xe "cutting ink strokes (Windows Journal)"

xe "erasing ink:cutting strokes (Windows Journal)"only part of a solid ink stroke, but you can cut an ink stroke in two with the Eraser tool and then select only one part. The erased area must be big enough that Journal understands you are cutting the ink rather than simply making a small correction. 
If after you cut a stroke the two parts remain grouped, manually ungroup them with the Ungroup command. Once separated, you can select and move each part. This is very helpful when editing a combination of text and drawings, as shown in Figure 3-16.
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Figure 3-16.   Use the Eraser tool to cut an ink stroke, ungroup if needed, and edit the ink.
Copy and Paste Ink

You can cut, copy, and paste xe "copying ink (Windows Journal)"

xe "pasting ink (Windows Journal)"ink objects within a note and into another note, the same way you can cut and paste text or graphics in most applications. When you paste ink into another application, Journal will paste the selection differently depending on what the application supports. Ideally, the ink itself will be pasted so that you can edit or convert it to text at a later date. If the application does not support ink, the next best option is to paste it as an image that can be resized but not edited. If neither option is available, the selected ink will be converted into text and pasted as text that may contain recognition errors. Figure 3-17 shows the result of pasting ink into Microsoft Outlook Express, where it has become a static image. For information on converting text in a Journal note to e-mail, see “Converting Selection to E-Mail” later in this chapter.
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Figure 3-17.   Journal will paste ink into another application as ink, a static image, or text, depending on the situation.

Converting Handwriting to Text

Every time xe "Windows Journal:converting handwriting to text"

xe "handwriting recognition:converting Journal handwriting to text"

xe "text:converting handwriting to, Windows Journal"

xe "converting handwriting to text. See handwriting recognition"you put ink on a page, Journal assesses the strokes to see if they might form a word. If Journal thinks the strokes do represent a word, they’re grouped and the handwriting recognizer records its best guess for the word as well as several alternatives. The list of possible words is stored as part of the Journal note. The process happens in the background, so it doesn’t interfere with your work, but if you choose to convert your handwriting to text, the recognition is already complete.

To access the recognized words and convert your handwriting to text, select the text you want converted and choose Convert Handwriting To Text from the Actions menu. This displays the Text Correction dialog box, shown in Figure 3-18, which is a more sophisticated version of the Input Panel text preview pane.
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Figure 3-18.   Recognition results of the Convert Handwriting To Text command.

Correct the text in the dialog xe "correcting errors:Windows Journal text conversion"

xe "errors:Windows Journal text conversion"box by selecting incorrect words and either by choosing the correct word from the alternatives provided on the right or by tapping the green carat and choosing a word from the shortcut menu. The alternative list on the right of the dialog box is a little longer than the shortcut menu and offers a wider range of words. The list on the shortcut menu is the same list you would see using Input Panel. It also uses the same dictionary, so vocabulary added in Journal will appear in Input Panel as well. If you choose the Rewrite option from the shortcut menu, Input Panel will open automatically.
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While the Text Correction xe "line breaks in Journal notes"

xe "preserving line breaks in Journal notes"

xe "deleting:line breaks in Journal notes"dialog box is open you may rearrange text by dragging and dropping, and you may also add or remove line breaks. By default, a line break is entered in the converted text wherever there was a new line in the Journal note. You can remove all these automatic line breaks by tapping the Options button and unchecking Preserve Line Breaks From Notes.

When you’re done, tap OK and Journal will ask if you want the converted text copied to the clipboard, preserving your original ink, or if you want the ink replaced by the converted text. This dialog box is shown in Figure 3-19.
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Figure 3-19.   What to do with converted text.

The original handwriting doesn’t need to be horizontal for recognition to work, but the order may be confused. Figure 3-20 shows multiple-orientation writing and the uncorrected converted text.xe "Windows Journal:converting handwriting to text"

xe "handwriting recognition:converting Journal handwriting to text"

xe "text:converting handwriting to, Windows Journal"
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Figure 3-20.   Handwriting recognition works, to an extent, in any orientation.
Converting Selection to E-mail

If you want to convert xe "Windows Journal:e-mail, sending text as"

xe "handwriting recognition:converting Journal text to e-mail"

xe "e-mail, sending from Windows Journal"Journal text and send it to an e-mail program, select Convert Selection To E-Mail on the Actions menu. Convert Selection To E-Mail uses the same Text Correction dialog box as Convert Handwriting To Text, but once finished, the text is inserted into the body of a new, blank e-mail message using your default e- mail program. An image of the original ink is added as an attachment as well. Convert Selection To E-Mail is a great way to delegate action items to specific people or forward a short bit of information found while reviewing your notes. If you have the Office XP Pack for Tablet PC installed, you will have additional options to convert ink to Outlook appointments, contacts, or tasks.xe "Windows Journal:editing notes"

xe "editing Windows Journal notes"
Printing Notes

Printing from Journal xe "Windows Journal:printing notes"

xe "printing:Windows Journal notes"is the same as printing from any other Windows application. Select Print from the File menu. The Options tab of the Print dialog box gives you the option to print or hide the rules on the note page and the background images. By default, the rules print but the background images do not, since they tend to interfere with readability. If you have a note where the background images are important, such as on a form, you can specify that they be printed.

Unless you write your Journal notes on an 8½-by-11-inch page, there will be a difference between the Journal note paper size and the actual paper size if you print your notes on letter-size paper. Usually the Journal note is smaller than the actual paper, in which case the note will appear at its actual size, centered in the page. If the note size is larger than the paper, it will be scaled down to fit. There is no option in Journal itself to print multiple note pages side-by-side on a single sheet of paper or to tile a note across several pages, but your printer may have options to do this.
Adding Text and Pictures to Notes

Although it’s very handy to just write and draw in Journal, xe "Windows Journal:formatting notes:adding typed text or pictures"

xe "formatting Windows Journal notes:adding typed text or pictures"

xe "graphics and images:adding pictures to Journal pages"

xe "text:adding typed text to Journal pages"sometimes you want to add typed text or pictures to your notes. Typed text in Journal notes are contained in rectangular areas called text boxes. You can also insert pictures of various file formats into your notes.
Using Text Boxes

There are three ways xe "text boxes"to create text boxes and put typed text in your note. The first one is to select handwriting in the note and convert it to text as was discussed in Chapter 3. After the conversion, one of your options is to replace the original ink with a text box. The second option is to copy text from another document and paste it into your note. The pasted text automatically appears in a text box. The third option is to insert a blank text box using the Insert menu. After inserting a blank text box, you can add text by using the Input Panel or a standard keyboard or by pasting.

Once the text box is in the document, it can be selected and moved just like any other object. xe "selecting:text boxes"

xe "moving:text boxes"To select the entire text box, tap the edge of the text box. The boundaries of the text box will appear, but there will be no flashing cursor inside. To make the flashing cursor appear amidst the text, tap the text. To select the text inside the text box, drag over the words you want selected. Figure 3-21 shows a text box with portion of that text selected.
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Figure 3-21.   Some text is selected inside a text box.
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When a text box is selected, a Format Text command xe "Format Text (Edit menu)"replaces the Format Ink command on the Edit menu. Choosing Format Text opens the Font dialog box shown in Figure 4-8. Exactly which text is affected by the Font dialog box depends on what you selected. If you drag the cursor to select part of the text in a text box, as shown in Figure 4-7, only that text is changed. If you select the entire text box rather than the text within it, all the text in the text box is affected. If you select several text boxes with the Selection Tool, all the text boxes are affected.


Using text in a note is useful when creating diagrams or maps, especially if the writing must be small. There are a few limitations you should know. Ink always appears in front of text boxes, so be careful not to obscure your text with ink. If you resize a group of text and ink to better fit on the page, the text will not reduce in font size automatically. It’s usually best to make all the text smaller first and then resize the drawing. Text in textboxes also can’t be rotated, so labeling tall, thin items on a drawing may take some creativity.
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Figure 3-22.   If text or a text box is selected, a Font dialog box replaces the Format Ink dialog box.

Inserting Pictures

Notes may xe "graphics and images:adding pictures to Journal pages"

xe "inserting:pictures to Windows Journal pages"contain pictures from clip art, digital cameras, Web sites, or virtually any other digital picture source. To add a picture to your note, either choose the Picture command from the Insert menu, or simply drag the picture file onto the note. Once the picture is inserted, you can select, move, or resize it just like any other object in the note. Ink will always appear in front of the picture, just as it does when used with text boxes. This is handy if you want to draw on the picture, as shown by my son’s party invitation in Figure 
3-23. Pictures added to a note are stored as part of the note file. If you plan to share the note with anyone, avoid pictures that take up a lot of disk space, especially if you plan to send the note via e-mail.
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Figure 3-23.   Pictures always appear behind any ink.
Templates

Journal templates are essentially pads of Journal note paper or stationery. When you create a new note from a template, you open a copy of the template file, and the original remains untouched. The new note opens with a blank name and is saved as a new Journal note. Templates are a great system for keeping a wide array of paper types on hand.

Using Built-in Templates

To create a new note using a template, xe "built-in templates, Windows Journal"

xe "templates, Windows Journal:built-in"

xe "stationery, Windows Journal:built-in"

xe "formatting Windows Journal notes:templates:built-in"choose the New Note From Template command from the File menu. By default, the Open dialog box will show the templates in your My Notes folder in your My Documents folder. Select the template you want, and tap Open. The templates shipped with Windows XP Tablet PC Edition include some custom paper types such as Genko sheets (for East Asian languages) and music paper, as shown in Figure 3-24. In addition to these options, more templates may become available from the Tablet PC Web site at http://www.microsoft.com/tabletpc/
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Figure 3-24.   Templates offer a wide array of paper types.
Setting a Default Template

If you want a template to open as your default new note, xe "default templates, Windows Journal"open Journal Options from the Tools menu. On the Note Format tab, select the Note Template option and select the template you want, as shown in Figure 4-11. After you apply the changes, all your new notes will use the template. This is a great option if you create a custom template to serve as your personalized note paper.
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Figure 3-25.   Set a default template on this tab.
Chapter 4:
Annotating, Sharing, and Organizing Journal Notes

Windows Journal has many useful features, but some are easy to overlook if you don’t know they are there. For example, you can import documents created in various applications into Journal. Although you can’t modify the imported documents, you can annotate them. This feature enables you to import a file your student has created and then make comments on that file in your own handwriting. So rather than give feedback on or grade hard copies of papers, you can use Journal and do it electronically. If necessary, you can export notes as graphic files to share notes with people who don’t have tablets. So even if your students don’t have their own tablets, they can still read your comments in an electronic file. The search capabilities of Journal include ink, text boxes, and imported text. You might also discover that Journal can be useful for presentations, meetings, and collaborative work between students.
Importing and Annotating Documents

Document import and xe "Windows Journal:importing and annotating documents"

xe "annotation in Windows Journal"

xe "importing documents into Windows Journal"

xe "document import into Windows Journal"annotation is one of Journal’s coolest and most useful features. The Import command is really a Print command. When you import a document into Journal, you essentially print it onto Journal paper, which becomes the background for a new document. You can then use your pen, highlighter, and eraser tools to mark up the pages just as you would a real page. The page is more than just a digital printout, however. You can store multiple versions of the same document. You can even search the imported text, which is something you can’t do on real paper. Once you have marked up the document, you could e-mail the final product to someone in full color, even if they don’t have a Tablet PC and Journal. Microsoft Word documents, Web pages, Microsoft PowerPoint slides, and pictures are all importable. If you can print it, you can import it into Journal.

To import a document into Journal, tap the Import button on the Standard toolbar or select Import from the File menu. Once you select the file to import, Journal will open the program used to read that file. The first time you import a file into Journal, a dialog box appears reminding you that Journal must open the original program to print the file into a Journal note and that the original program must be installed on your computer. xe "Import dialog box"This Import dialog box is shown in Figure 4-1. If the program that created the file is not installed on your computer, you may have trouble importing the note. For example, if you’re sent a WordPerfect document and you use Word, you may need to open the document in Word and save it as a Word file before importing it into Journal. The dialog box appears every time you import a note until you check the Don’t Show Me This Again check box.
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Figure 4-1.   When importing a document into Journal, the document will be opened in its default program.

Imported documents always xe "size:imported documents"open as a new note with the same page dimensions as the original document. Because many of the files you will import will be 8.5- by-11-inch pages, the text may appear rather small on the tablet screen. Adjust the view setting as you work to show the whole page as you scan through the document, and zoom in when you need to see the text more clearly. Reading view is especially helpful when you’re scanning a multi-page document. The contents of the imported document are treated identically to a non-editable picture on a Journal template. You can write ink and insert text boxes or pictures on the surface of the imported material, but you cannot select or change it. Figure 4-2 shows an example Journal note created from an imported Word document and annotated with pens and highlighters. Even though the imported document is non-editable, it is not a background image, so it will print even when the option for printing backgrounds is unchecked.xe "annotation in Windows Journal"
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Figure 4-2.   Mark up imported documents just as you would real paper.
Importing by Printing to Journal Note Writer

Another way to xe "printing:to Journal Note Writer"

xe "Journal Note Writer:printing to"

xe "Windows Journal:importing and annotating documents:printing to Journal Note Writer"

xe "importing documents into Windows Journal:printing to Journal Note Writer "

xe "document import into Windows Journal:printing to Journal Note Writer"import documents into Journal is to use the Journal Note Writer driver. If you’re working in an application (such as Word) and you want to use the current document in Journal, you can print the document and select Journal Note Writer as the printer as shown in Figure 4-3. Instead of printing the document, Journal will convert the document to a Journal note file. You’ll be given the opportunity to specify name and location of the Journal note file. Once the Journal note file is created, it is automatically opened in Journal. Printing to Journal Note Writer has exactly the same result as the Import command but doesn’t require opening Journal first.
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Figure 4-3.   Printing to Journal Note Writer is another way to import documents into Journal.
Inserting Pages and Space on Imported Documents

Adding pages to xe "inserting:pages/space into imported documents"

xe "pages:inserting into imported documents"

xe "space:inserting into imported documents"

xe "vertical space:inserting into imported documents"

xe "new pages to Windows Journal, adding:imported documents"imported documents works similarly to other Journal notes. To add more pages after the imported pages, tap the Next/New Page button, and to insert pages before the page you’re viewing, select New Page from the Insert menu. The new pages will have the same style and background used for your new notes, but they will have the paper size of the imported page. So, if your notes are normally on 5.5- by-8.5-inch graph paper and the document you imported was 8.5 by 11 inches, then all pages you add to the imported document will be 8.5-by-11-inch graph paper. If you want to customize how additional pages appear, you can change the size and format of the paper using Page Setup. Journal will not change the size of the imported pages, however, so your Journal note will contain two different page sizes.

xe "inserting:pages/space into imported documents"

xe "pages:inserting into imported documents"

xe "space:inserting into imported documents"

xe "vertical space:inserting into imported documents"

xe "new pages to Windows Journal, adding:imported documents"
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Figure 4-4.   The Insert/Remove Space tool does not affect the underlying imported document.
Document Import Options

Sometimes documents xe "Windows Journal:importing and annotating documents:import options"

xe "importing documents into Windows Journal:import options"

xe "document import into Windows Journal:import options"will not import correctly using the standard Import command. This could be the result of missing fonts or linked files on your computer or peculiarities of the original program. If you experience problems importing a document, you can try importing the document as an image instead. Importing the document as an image will take longer, and you won’t be able to search the imported document text. Searching notes will be discussed in Searching Notes later in the chapter.

To import documents as images, xe "graphics and images:importing documents as"open the Journal Options dialog box and tap the File Import Preferences button on the Other tab to display the Journal Note Writer Properties dialog box. Switch the output format to Print As An Image, as shown in Figure 4-5. Once you have imported the file, be sure to switch the preference back. Importing files as images should be used only when necessary.
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Figure 4-5.   If importing a document the standard way doesn’t work, you can try importing the document as an image.

Sharing Journal Files

If you want to xe "sharing Journal notes"

xe "Windows Journal:sharing and exporting notes"

xe "exporting Journal notes"share a Journal note with another tablet user, just send them the note. All the information, including ink, imported documents, text boxes, and pictures are saved in the note file. If you want to share your Journal notes with someone who does not have a tablet, and therefore does not have Journal, you must export the note either as a Web archive file (.mht) or as a Tagged Image File Format image (.tif).
Exporting a Note as a Web Archive 

Web archive files xe "Web archive files"

xe ".mht (Web archive) files"are essentially self-contained Web pages that include text and graphics in a single file. Web archive files are readable by Internet Explorer 5 or later, on both Windows or Macintosh platforms, and by most Microsoft Office programs. Web archive files are in color and can be a single page or multiple pages. When displaying Web archive files, Internet Explorer shows a bar above the page that includes navigation buttons, the current page number, and possibly a zoom drop-down list, as shown in Figure 4-6. To export a note as a Web archive file, select Export As on the File menu and select Web Archive as the file type.
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Figure 4-6.   Exporting to Web archive format lets you share your files with people who do not have a tablet and Journal.
Exporting a Note as TIFF

xe "TIFF files:exporting Journal notes as"Notes can be exported as Tagged Image File Format (TIFF) files. These files are only in black and white, but they are readable by just about anyone. TIFF files also have a higher resolution than Web archive files and print better for notes containing predominantly text. xe "formatted Windows Journal notes:highlighted ink:appearance in TIFF format"

xe "Windows Journal:formatting notes:highlighted ink"

xe "highlighters, Windows Journal:TIFF format, highlight appearance in"Highlighted text and photographic images look terrible in the TIFF format—often so bad they are unreadable. TIFF files containing more than one page are also unreadable by some programs. In general, Web archive is the best format for sharing your Journal files, but if the Web archive file isn’t working, you can try the TIFF format. To export a note in the TIFF format, select Export As on the File menu and select Tagged Image File Format as the file type.
Sending as E-mail

If you are going xe "e-mail, sending from Windows Journal"

xe "Windows Journal:e-mail, sending text as"to send a note by e-mail, you can make the process of exporting shorter by selecting xe "Send To Mail Recipient (File menu)"Send To Mail Recipient on the File menu. Journal will ask which of three formats, Journal note, Web archive, or TIFF, you want to use, as shown in Figure 4-7, and then will create a blank e-mail message with the note already attached.xe "sharing Journal notes"

xe "Windows Journal:sharing and exporting notes"

xe "exporting Journal notes"
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Figure 4-7.   You have a couple of different options when using the Send To Mail Recipient command.
Searching Notes

xe "Windows Journal:searching notes"

xe "searching Journal notes"

xe "Find pane (searching notes)"

xe "words, alternate (writing panel):effect on searching notes"

xe "alternate words list (writing panel):effect on searching notes"

xe "handwriting recognition:alternate words list:effect on searching notes"

xe "writing pad:alternate words list:effect on searching notes"

xe "fuzzy find process"Journal performs background handwriting recognition on your ink as you lay it down on the page and stores the list of probable words and alternatives. The word list is used both for converting your ink to text and for finding words in your notes. When you search your notes using the Find command, Journal will show all items in which your search text matches the words it recognized or any of the top six alternatives. This “fuzzy find” is a bit of a trade-off. By finding alternatives, you are more likely to find the text you want, but you will also find several near misses. To search your current note for specific text, select Find from the Edit menu or tap the Find button on the Standard toolbar to make the Find pane appear, as shown in Figure 4-8.
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Figure 4-8.   Use the Find pane to quickly search for text in your note.

Tap the Look For field, and use Input Panel to enter your search text. Next tap Find. The first match in the document will appear selected. Continue searching the document by tapping Next until you find the text you want. Find is not case-sensitive and you cannot search for more than one word or phrase at a time. Figure 4-9 shows a typical search result in which the word “specific” is found correctly, but tapping Next finds the similar word “pacific.”
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Figure 4-9.   The Find command returns words that match or are similar to your search text.
Searching Within Text Boxes and Imported Documents

Text boxes and the xe "Windows Journal:importing and annotating documents:searching within imported documents"

xe "importing documents into Windows Journal:searching within imported documents"

xe "document import into Windows Journal:searching within imported documents"

xe "text boxes:searching within"imported document text can be included in the search as well, but the results will depend on how the text was inserted. Text boxes created from handwriting converted to text retain their alternate words list, so the fuzzy find still applies, and similar words are included in the results. If the text box contains text pasted from another program, there is no alternate list, and only exact matches are found. In either case, Find selects the entire text box, rather than a single word within it, but this usually isn’t a problem because text boxes rarely contain more than a paragraph of text. If the note contains text imported via the Import command using the standard import, all the imported text is included, but only for exact matches. When one of these words is found, it appears highlighted. Documents imported as images, as well as any words contained within an image, are not included in the search. Figure 4-10 shows how ink, text boxes, and imported text would appear in a search for the word “campaign.” In reality, only one of these found words would be selected at a time and you would use the Next and Previous buttons to move between them. Notice that the word “campaign” in the picture was not found by the search.
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Figure 4-10.   Here are examples of how search results appear for ink, text boxes, and imported text. Text in pictures cannot be searched.
Setting Search Options

If you don’t want alternate wordsxe "Find pane (searching notes)"

xe "words, alternate (writing panel):effect on searching notes"

xe "alternate words list (writing panel):effect on searching notes"

xe "handwriting recognition:alternate words list:effect on searching notes"

xe "writing pad:alternate words list:effect on searching notes"

xe "fuzzy find process" or the imported text included in your search, tap the More button on the right of the Find pane and uncheck the options for xe "Include Document Image Text option"

xe "Include Close Matches option"Include Close Matches or Include Document Image Text as needed. The xe "expanded Find pane"expanded Find pane also provides an option for finding flags xe "flags, Windows Journal:searching for"

xe "Windows Journal:flags:searching for"instead of text. The expanded Find pane is shown in Figure 4-11.xe "Windows Journal:importing and annotating documents:searching within imported documents"

xe "importing documents into Windows Journal:searching within imported documents"

xe "document import into Windows Journal:searching within imported documents"
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Figure 4-11.   Use the expanded Find pane to specify additional search parameters.
Searching Across Multiple Notes

By default, Find searches only your current note. To search through multiple notes, enter the search text in the Look For field of the Find pane and then specify in the Look In field the folder or drive you want searched. If the Find pane is expanded, you’ll notice that additional options are enabled. You have options to limit your search by specific dates and whether to search subfolders. After you specify your options and tap Find, the note list pane opens, showing all the notes that contain matches. Tapping any note in the note list opens that note at the place of the first match. Tapping Next finds the next match in that note. Once the end of the note is reached, tapping Next finds the first match in the next note on the list. Figure 4-12 shows an example search across multiple notes. xe "Windows Journal:searching notes"

xe "searching Journal notes"

xe "Find pane (searching notes)"
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Figure 4-12.   Your search results are listed in your current note.
Presentations and Meetings Using Journal

When it comes to making digital presentations, xe "Windows Journal:presentations and meetings"

xe "digital presentations with Windows Journal"

xe "presentations with Windows Journal"

xe "meetings with Windows Journal"

xe "collaboration with Windows Journal"PowerPoint may have the corner on the market, but Journal can be a powerful presentation tool. Journal offers much more sophisticated and flexible pen and highlighter tools, lets you switch quickly to a blank writing surface, and provides the ability to select and edit objects you just drew. If your presentation is highly interactive, Journal may be the best tool for the job. In fact, some of the people testing tablets during development imported entire PowerPoint presentations into Journal just to take advantage of the pen and editing tools. Importing a document into Journal and then projecting it on a screen is also a great way to work collaboratively in a small or large group.

Here are a few tips for getting the most out of Journal as a presentation and collaboration tool.

· Switch to landscape orientation if you’re using an LCD projector   If you forget to do this it will be obvious when you turn on the projector and the image is sideways! Switching beforehand is less embarrassing.

· Use full-screen view   Full-screen view makes your presentation as large and visible as possible. Making the most of screen space is especially important when viewing portrait orientation documents on a landscape orientation screen, which most digital projectors require. Full-screen view also hides other distracting programs, the taskbar, and extra toolbars.

· Customize the Journal toolbars   When in full-screen view, Journal shows different default toolbars. If you’re viewing landscape orientation documents, such as imported PowerPoint slides, arrange the toolbars onto one line to use less space. If you’re viewing portrait orientation documents, consider turning off the toolbars altogether. All the commands to change pens and tools are still available through the menus.

· Use reading view if appropriate   Reading view is a great way to move through a document one page or one screen at a time. Either the down arrow or the Spacebar will advance you to the next page.

· Display the page bar if appropriate   The page bar shows all the pages in your note as numbered blocks, and you can jump to any page by tapping that block. This is very handy with large documents but can be distracting to your audience as they wonder what is on the upcoming slides.

Figure 4-13 shows an imported PowerPoint presentation in full-screen view with reading view and the page bar turned on.xe "Windows Journal:presentations and meetings"

xe "presentations with Windows Journal"

xe "digital presentations with Windows Journal"

xe "meetings with Windows Journal"

xe "collaboration with Windows Journal"
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Figure 4-13.   Use full-screen view and the page bar when using Journal for presentations.
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Tip


Windows XP and Journal use Microsoft ClearType technology �xe "ClearType technology"��xe "Microsoft ClearType technology"�to improve the readability of text on the screen. If you are having trouble reading a document in an application that does not support ClearType, try importing the document into Journal.


     To make sure ClearType is turned on, open the Display control panel, tap the Appearance tab, and tap the Effects button. In the Effects dialog box, make sure Use The Following Method To Smooth Edges Of Screen Fonts is checked and make sure ClearType is selected in the drop-down list.
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Tip


If you want to insert a picture of an entire document, such as a fax, into a note and mark it up with comments, use the Import command on the File menu, described in Chapter 4, rather than Insert Picture.
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Tip


You can change the color of text using either the Font dialog box or the Format toolbar; however, the dialog box offers only sixteen color options, while the Format toolbar offers millions using custom colors.
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Tip


If you want the converted text put on the clipboard, choose Copy As Text from the Edit menu rather than Convert Handwriting To Text from the Actions menu. This avoids the final dialog box.
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Tip�If you draw a box around text and it is too small, tap the box to select it without selecting the text and then increase the box size to fit more text.
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Tip


You can delete the note currently selected in the note list by pressing the Delete key on Input Panel. �xe "Windows Journal:managing notes"�
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Tip


Double-tapping a filename in the Journal notes opens it in new window. Right- tapping a filename opens a shortcut menu options for opening, moving, deleting, or sending the note.
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Tip


The stroke eraser is a great way to erase highlighting but leave the underlying ink untouched.








�


Tip�Create a color code system for your notes and make a pen for each color. For example, your notes could be in black, “to do” items in red, and ideas in purple. When you review your notes it’s easy to pick out each type of information. You can also create a similar system with highlighters.








�


Tip


Write Anywhere also understands the scratch-out gesture to remove ink before it is converted to text.








�





�


Try This


With many applications, once the text leaves Input Panel the alternate list is lost. Some applications, however, such as Word 2002 (with the Microsoft Office XP Pack for Tablet PC installed), let you access the alternate words list even after the text is inserted into the document. If the application you are using has this type of pen integration, then the text preview pane serves little purpose.











�


Tip


If you want more space on the writing pad, you can also add the quick keys pad to the Input Panel title bar as a button and remove the quick keys pad from the main Input Panel window. See “Setting Input Panel Options” later in this chapter for more information.





�





�





�


Tip


Keyboard commands, such as Ctrl+C for copy are cumbersome to enter on the Input Panel keyboard. Tap buttons or use the menus instead of the Input Panel keyboard.








�





�


Tip


Change Tablet And Pen Settings also lets you quickly toggle the speaker on and off (handy if you don’t want to bother your neighbor on the airplane) and turn the screen off to save battery power. The Properties item takes you directly to the Tablet And Pen settings control panel.








�





�


Tip


If you’re having continued trouble getting your pen to work and you already tried tapping harder, try holding the pen more upright. This will improve the alignment between the pen tip and the cursor. Sometimes, when the pen is at a serious angle, the cursor is off to one side, almost as if it is a “shadow” cast by the pen. Also, the tip of the pen must compress slightly to send a signal. If the pen is held at too much of an angle, the tip will slide over the screen rather than compress.








�


Tip


Clean your screen often. When you rest your hand on the screen it gets dirty quite quickly. Many office supply outlets and computer stores sell anti-static wipes for cleaning computer monitors that work very well.





�


Glossary


Ink is a term for the pen strokes you create on the tablet screen. These strokes are not recorded as images. Instead, they’re represented by equations describing the relative sizes, angles, and directions of the lines. In different situations, your ink might be converted to text, converted to an image, or saved in its original format.


   To hover with your pen is to �xe "hovering"�bring your pen close enough to the screen to move the cursor but not actually touch the screen. Hovering allows you to control the cursor without the risk of an accidental tap or drag.
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�


Tip


Find starts looking on whatever page you are viewing. If you want to search an entire note, either start your search from the first page or say yes when asked whether you want to continue your search from the beginning of the note.








�


Try This


Open and tear off the quick keys pad and symbols pad from Input Panel, and then hide Input Panel. Next open a blank e�mail message, and try entering all the information using Write Anywhere. If possible, write a couple of paragraphs so that you can experiment with correction and editing.





�


Caution


It’s very easy to accidentally select the wrong item on a shortcut menu if you keep the pen in contact with the screen after the shortcut menu appears.


Caution  	It’s very easy to accidentally select the wrong item on a shortcut menu if you keep the pen in contact with the screen after the shortcut menu appears.








�


Glossary


To tap is the pen equivalent of a click. Where you would click with a mouse button, you tap with your pen.


Caution  	It’s very easy to accidentally select the wrong item on a shortcut menu if you keep the pen in contact with the screen after the shortcut menu appears.








�


Tip


Even though it’s called “Send,” this Send button has nothing to do with e-mail; it just sends what it reads to the current program. Don’t tap Enter on Input Panel instead of Send. That will send the text and send an Enter command. If you were writing a filename in a Save dialog box when this happened, the file would save before you could see and correct the filename.








�


Note


If text appears in the text preview pane but the Send Text button is grayed out, you probably haven’t placed the cursor telling Input Panel where you want the text to go.








�


Try This


Open a blank document in your favorite e-mail program, and try writing a quick letter to a friend using Input Panel. Use the pen to tap your way through creating a new message and entering his or her e-mail address. Use the Input Panel keyboard to tap in your e-mail address in the CC box. Write a sentence using the writing pad with text preview off, and correct it in the message. Next write a sentence with text preview on, and make your corrections in the text preview pane. Try mixtures of the different input methods and see which system works best for you and in what contexts.











�


Try This


To get a feel for how the ink you create in Journal differs from the lines you might make in a paint program like Microsoft Paint, open them both and draw a curved line. Now zoom in on each line and compare the two. The Journal line will be equally smooth at any zoom setting. The Paint line will get more and more grainy, or pixilated, as you zoom in. This is because Journal records your ink strokes as complex equations, called Bezier curves, rather than as dots on the screen. The result is a line that is smoothed as you write it and is equally clear no matter how you resize it. This same technology is used by artists operating high- end computer illustration software. The Bezier curve also stores the direction the line was drawn, which provides key information for handwriting recognition.








�


Note


The scratch out gesture must be enabled on the Other tab of the Journal Options dialog box to have an effect. If you get scratch outs when you don’t want them, you can disable this feature.








�


Note


The note title area only applies to the first page of a multi-page note. The note title area does not appear on subsequent pages.








�


Note


You can customize the position of the note list, as well as number of recently used folders and note listed in the note list, using the View tab of the Journal Options dialog box. You can also set whether the list of recently used notes in the file menu appears as note titles or filenames.








�


Note


The New Page/Next button will not create a new page if the current page is still blank.








�


Note


Grouped ink is a set of several ink strokes that should stay together if they’re moved throughout the document, such as all the strokes that create a single word. See Selecting Ink and Grouping Ink later in this chapter for more information.








�


Note


By default, the Insert/Remove Space tool will only insert space in increments the same size as the rules on your page. If it did not, you would almost certainly end up with some extra wide or extra narrow spaces between rules. You can disable this option on the View tab of the Journal Options dialog box.








�


Note


Grouping is essential for Journal to recognize your handwriting as text. If you group several words as one in an effort to keep them together, handwriting recognition will not understand those words correctly.








�


Note


You don’t need to switch to the Selection Tool to select objects using right-tap, tap-and-hold, or right-drag. This lets you make selections without changing tools.








�


Note


There’s no way to merge two notes, but you can use Select All and Select Page to paste notes together one page at a time.








�


Tip


If you select ink, tap the Ctrl button on Input Panel or hold down the Ctrl button on a standard keyboard, and then drag the selection. A copy of the selection appears in the new location.








�


Note


The default text box font and size are set on the Note Format tab of the Journal Options dialog box.








�


Note


You cannot simultaneously format text and ink.








�


Note


A template is a file that contains the appearance and settings for a new Journal note. In a custom template, you can choose whether to include ink, pictures, and text boxes and whether to make these objects editable.








�


Caution


Opening a template file, instead of creating a new note from the template using the File menu, opens the original file. If you make changes and save them, they will be permanently added to the template.








�


Try This


The next time �xe "editing:marking up imported documents"�you need to fill out a form using a file on your computer, rather than printing it and filling it out, import it into Journal. Use Journal to fill out the form, taking advantage of the ability to correct mistakes and convert your handwriting to text if needed. When you are done, you can print out the form already completed and save a copy for your records. If it’s a form you use regularly, you can make it into a template.








�


Try This


The Insert/Remove Space tool �xe "deleting:vertical space from imported documents"�works a bit differently on pages with imported documents. Since the document itself is not editable, the Insert/Remove Space tool will move your ink but leave the underlying imported document untouched. This can wreak havoc on your annotations, as shown in Figure �4-4. There is no option to make the page longer when using the Insert/ Remove Space tool on an imported document. If you push items off the bottom of the page, they will automatically move onto a new blank page.








�


Tip


If you have an office intranet, you can share Journal notes on the company Web site in Web archive format.








�


Note   


If you use the Search tool on the Start menu to search for text within documents, it will find matches to handwritten words, text boxes, and imported document text in Journal notes. It will see only the handwriting recognizer’s most likely word, however, and not any of the alternates.








�


Caution


If you have text selected in the text preview pane or in a document and you make a gesture, the selected text will be deleted.
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